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VTrak S3000 Task List

» Task 1: Unpacking the Boxes (below)

« Task 2: Mounting the Appliance in a Rack (page 4)

+  Task 3: Configuring the VTrak Appliance (page 8)

»  Task 4: Mounting the Subsystem in a Rack (page 23)

* Task 5: Installing Disk Drives in the Subsystem (page 26)
+  Task 6: Making Data Connections (page 28)

*  Task 7: Making Management Connections (page 34)

+  Task 8: Setting-up Serial Cable Connections (page 37)

+  Task 9: Powering-on the Subsystem (page 38)

*  Task 10: Setting-up the Subsystem (page 40)

+  Task 11: Configuring Storage on the Subsystem (page 46)
+ Task 12: Setting-up Basic Storage (page 54)

»  Task 13: Setting-up High Availability (page 62)

*  Contacting Technical Support (page 68)

Thank you for your purchase of the VTrak S3000 storage solution. This Quick
Start Guide is designed to help you unpack, install, connect, configure, and run
your VTrak S3000 system.

If you are adding VTrak RAID subsystems or JBOD enclosures to your VTrak
S3000 system, follow the Task List in this document. The Task Lists in other
Quick Start Guides do not cover VTrak S3000.

For complete information about your VTrak S3000 appliance, see the VTrak
S3000 User Manual on the software DVD.

Please see the software DVD for a complete set of user documents.

Task 1: Unpacking the Box

The VTrak S3000 appliance box contains the following items:
* VTrak appliance

+ Bezel

+  Left and right mounting rails for the appliance

1.5 m (4.9 ft) Power cords, 2 each

*  Accessory box

+  Printed software license key

+  DVD with software install files and user documentation
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Task 1: Unpacking the Box

>p

Warning

The electronic components within the VTrak appliances and
subsystems are sensitive to damage from Electro-Static
Discharge (ESD). Observe appropriate precautions at all times
when handling the VTrak or its subassemblies.

Important

To run the PROMISE Management Console, your PC must have
the latest version of Java Runtime Environment (JRE).
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Task 2: Mounting the Appliance in a Rack

Identifying the Sections of the Rack Rails

The chassis package includes two rack rail assemblies in the rack mounting kit.
Each assembly consists of two sections:

* A pair of two-piece chassis rails that attach to the chassis
« A pair of two-piece rack rails that attach to the rack

Figure 1. Appliance rack mount components

- Rack rail extensions
- Rack rails

Chassis rail

/ -+— extensions

Chassis raiI
(both sides)

Inner Chassis Rails

The chassis rails come in two sections:
* Chassis rails — Attached to the chassis at the factory
. Chassis rail extensions — You attach them to the chassis rails

Installing the Chassis Rail Extensions

1. Place the chassis rail extensions on the side of the chassis aligning the
hooks on the chassis with the holes on the rail extensions.
The inner rail extension faces “outward” the same as the inner rail.

2. Slide the rail extension toward the front of the chassis.

3. Secure the chassis with two attaching screws as shown in the diagram.
Use the screws supplied with the rack mount kit. See page 5, Figure 2.

4. Repeat steps 1 through 3 for the other chassis rail extension.




Task 2: Mounting the Appliance in a Rack

Figure 2. Assembling the chassis rails
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screw
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Installing the Rack Rails into the Rack

1. Attach the longer section of the rack rail to the shorter section of the rack rail.

Align the pins with the slides. Both brackets of the rack rail must face the
same direction in order to secure to the rack.

2. Adjust the length of the two sections of the rack rail so that they fit snugly in
the rack. See Figure 3.

*  The longer section of the rack rail attaches to the front rack post.
»  The shorter section of the rack rail attaches to the rear rack post

Figure 3. Assembling the rack rails

Rear bracket

N <4«— Front bracket Attaching points

3. Secure the rail brackets to the rack posts.
Use the M5 screws included with the rackmount kit. See page 6, Figure 4.
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4. Repeat steps 1 through 3 for the remaining rack rail.

Figure 4. Installing the rack rails

M5 attaching screws

Rack front post : ) i b

Rack rear post . 7

5. Pick up the appliance and line-up the chassis rails on the rear of the
appliance with the front rack rails.
See page 7, Figure 5.

6. Slide the appliance into the rack.
If needed, press the locking tabs on the chassis rail to slide the appliance
into position.
When you have pushed the appliance all the way into the rack, the locking
tabs make a “click” sound.




Task 2: Mounting the Appliance in a Rack

Figure 5. Appliance rack mount assembly diagram
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Task 3: Configuring the VTrak Appliance

VTrak appliance configuration is done through the PROMISE Management
Console over a network connection. This process takes about 15 minutes.

When you add the VTrak appliance to your network, be sure the Host PC, where
you plan to run the Management Console, can connect with the VTrak appliance
over the network.

Before you begin configuration, obtain four dedicated IP addresses from your
Network Administrator:

Ethernet port 0 (ethQ)
IPMI LAN

Heartbeat

Health Monitor

Making Power and Network Connections

To make power and network connections on the appliance:

1.
2.
3.

Plug the power cords into power supplies.

Attach at least one active LAN cable to one of the network ports.
Attach an active LAN cable to the IPMI port.

See Figure 6 for an example.

Figure 6. VTrak appliance setup connections

Power supplies IPMI LAN port

= =0 :@m@ @m@mm '5".

1 Gb/s Management port 1 Gb/s Heartbeat port

Accessing the Power Button

To access the power button and boot the VTrak appliance:

1.

2.
3.
4

Unlock the bezel.

Push the bezel release tab to the left to release the bezel. See Figure 7.
Remove the bezel and set it aside.

Press the power button to boot the VTrak appliance.

See Figure 8.




Task 3: Configuring the VTrak Appliance

Figure 7. Removing the bezel from the VTrak appliance
Bezel lock Bezel release tab
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Figure 8. VTrak appliance power and reset buttons

Reset button Power button

1INl DDDDDIO|l I IH|EHEHecoc00 00 |
R e e

As the appliance boots, the GRUB screen shows a choice of kernels.
5. Choose Promise VTrak S3000 2.6.18-128.el5.

6. When the login appears, type root for the user name and password1 for the
password.

Logging into the Management Console

The PROMISE Management Console is your interface with the software running
on the VTrak appliance. To run the Management Console, your PC must have the
latest version of JRE installed. You make the initial connection to the
Management Console through your network browser.

To log into the Management Console:
1. Launch your network browser.
2. Inthe browser’s address field, type http://192.168.253.10 and press Enter.

) Mozilla Firefox |Z||E|[$__<|
File Edit Wiew History  Bookmarks  Tools  Help

v £ hitp:/{182. 168.253.10 L 2

| (untitled)

VTrak appliance IP address
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The Opening launch.jnip dialog box appears.

Opening launch.jnlp

‘fou have chosen to open

m launch.jnlp
which is a: JMLP File
from: http:/f192.168.253.10

What should Firefox do with this file?

(%) Open with; | Javai TM) wWeb Start Launcher {default) b |

() Save File

[] Da this automnatically For files like this From now an,

[ QK %J [ Cancel ]

3. Inthe Opening launch.jnlp dialog box, choose the Open with option, choose
Java Web Start Launcher from the dropdown menu, and click the OK
button.

JRE launches on your PC.
If a Warning — Security dialog box appears, click the Run button to continue.

The Management Console splash screen appears.

PROMISE
TECHNOLOGY, INC.

The first time you log into the Management Console, the End User License
Agreement appears.
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Task 3: Configuring the VTrak Appliance

4. Review the agreement, then click the Accept button to continue.
You must accept the agreement to run the Management Console.
The agreement only appears the first time you log in.

PROMISE’
TECHNOLOGY, INC.

Please read the following license agreement carefully.
PROMISE TECHNMOLOGY, INC, END USER LICENSE AGREEMENT

READ THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING KEY CODE OR USING THE
PRODUCT. BY INSTALLING KEY CODE OR USING THE PRODUCT, YOU INDICATE Y¥OUR
ACCEPTAMGE OF THE TERMS OF THE FOLLOWING AGREEMENT. THESE TERMS APPLY TO YOL
ANMD ANY SUBSEGQUENT LICEMNSEE OF THIS PRODUCT. IF YOU DO NOT ACCEFT OR AGREE

TO THE TERMS OF THIS AGREEMENT, vOU MUST RETURN THIS KE'Y CODE AND ALL THE

o, [ e |
Lt

After the Management Console opens, you can close your browser.

5. Right-click Servers at the top of the Tree and choose Add.

# Promise Management Console

File Edit wiew Tools Help

Q8P
=
[ oot

Discaver

Replication Status Reports b

The VTrak User Login dialog box appears.
6. In the dialog box, enter the following information in the fields provided,
* IP address. The default is 192.168.253.10.
*  User name. The default is root.
»  Password. The default is password1.
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7. Click the OK button.

43 VTrak User Login

@j Enter WTrak Server login information

YTrak Server; |192.168.253.10 |

User Mame: |r00t |

Passward: |u-uuu |

8. The VTrak appliance is added to the Tree in the Management Console.

& Promise Management Console
File Edit ‘Wiew Tools Help

SRS

1D servers

n@ YTrak-01

n}@ FPhysical Resources

G-l Logical Resources
Q@J Replication

::- i[3) SAM Clients

ﬁ [#] Reports

The first time you connect to a VTrak appliance, the Configure VTrak dialog
box appears.

Configure ¥Trak

[:> Step 1: Enter license keys
Step 2i Setup nekwark.
Step 3: Set hostname

Step 4: Configure IPMI

| Reset steps | L Next!}é[ Skip ] [ Cancel ]

9. In the dialog box, click the Next button to begin configuration.
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Task 3: Configuring the VTrak Appliance

Step 1: Entering License Keycodes

Caution

Before you continue, be sure that no RAID subsystems are
connected, through network or fabric, to the VTrak appliance.

Keycodes are used to enable functions on the VTrak appliance. Each VTrak
appliance comes with a set of printed keycodes.

If your VTrak appliance has a connection to the Internet, the keycodes are
registered with a PROMISE-approved license server automatically.

When you click the Next button in the Configure VTrak dialog box, the License
Information dialog box appears.

1. In the dialog box, click the Add button.

!@ License Information

Keycodes Detail | License Summary
Kewvcade Tvpe Registration
Options:
[ Remove ]| [ Register ]| [ Register All ]|

The Add License Keycode dialog box appears.

2. Inthe dialog box, enter or copy-and-paste the keycode for your configuration
and click the OK button.

Add License Keycode @

Keycode: |N84DT -HQFHX -DCFMNR -RO3LM -OMFYM -

13
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3.

The License Information dialog box displays your keycode and the options or
features this license enables.

The Basic license enables:

+ 8iSCSIl ports

+  Failover

*  Mirror

+  Email Alerts

*  Replication with Encryption/Compression
* iSCSI boot

* 128 Snapshots

*  Unlimited Clients

» 1 Storage Shelf

The license shown below also enables eight (8) Fibre Channel ports.

The term Storage Shelf means that the appliance is enabled to work with
one VTrak RAID subsystem. You can enable additional RAID subsystems or
JBOD enclosures by adding shelf keys.

The keycode sample shown here is for demonstration purposes only. It is not
a valid keycode and cannot enable a license.

!@ License Information

Keycodes Detail | License Summary

Kevcode Tvpe Registration
ME40THAFHADCF NRR 9310 ONFAM |Standard |D0ne
Options:

Standard license for NSS, Promise Base (3 iSCSI ports, Failover, Mirror, Email Alerts,
Replication with Encryption/Compression, iSCS| Boot, 64 Snapshots, Unlimited Clients, 1
Storage Shelf), § Fibre Channel ports,

| [ Remove ]| [ Register ]| [ Register All ]|

g

Check the registration status of the license key.

+ Ifthe icon left of the license keycode is green and it says Done under
Registration, the license was registered automatically. Click the OK
button.
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Task 3: Configuring the VTrak Appliance

The VTrak Configure dialog box appears, ready for Step 2.

If the icon left of the license keycode is yellow, and it says No - 60 days
left under Registration, you might be required to register the license

manually.
See “Manual License Registration” below.

Manual License Registration

This action is for license keys that do not register automatically. Your VTrak must

have a connection to the Internet for registration.

1. Inthe License Information dialog box, click the Register button.
If you have multiple license keys, click the Register All button.

A} License Information

Keycodes Detail | License Summary

Kewvcode Tvpe Registration
ME40THQFHXDCF NRR93LM ONF3M Standard Mo - 60 days left
Options:

Standard license for NSS, Promise Base (3 iSCSI ports, Failover, Mirror, Email Alerts,
Replication with Encryption/Compression, iSCS] Boot, 64 Snapshots, Unlimited Clients, 1
Storage Shelf), § Fibre Channel ports,

[ Add Ii [ Remove ]| l Registerﬂ [ Register All ]|

The Register License wizard opens.
2. Click the Next button to continue.
3. Choose the registration option and click the Next button,

*  Online — The wizard attempts to register your license automatically over

the Internet.

If registration is successful, you return to the License Information dialog

box and the license key shows Done under Registration.

If registration is not successful, you can try again later. Or choose the

Offline option.

»  Offline — The wizard generates a data (.dat) file that you must upload to

PROMISE Support Center.
If you choose Offline, the Offline Registration dialog box appears.
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Register License

Offline Registration

Followe the steps to finish offline registration:

1. Input the file name, and then click =Save= hutton to save the registration data to local disk.

Filename: | C:idanieldialunregkeycodes.dak E]
2. Please log into PROMISE Support Center: hitps:iisupport promise.com to upload the license registration
data file

3 Inputthe file name you received and click =Send= button to finish license registration

Filename: |C:\danieldikevcodeRegistration. sig E]
[ Back ]| [ Finish [\” [ Cancel ]|

4. In the dialog box, click the ... button, navigate to a location to save the data
file, click the Open button, then click the Save button.

5. In your browser, log into the PROMISE Support Center.
https://support.promise.com
6. Upload the data file.
PROMISE Support returns a signature (.sig) file.

7. In the Offline Registration dialog box, click the ... button, navigate to the
signature file, click the Open button, then click the Send button.

The Send button applies the signature file to your license.

8. Click the Finish button to exit the wizard and return to the License
Information dialog box.

If the operation succeeded, the icon left of the license keycode is green and
it says Done under Registration.

9. In the dialog box, click the OK button.
The VTrak Configure dialog box appears, ready for Step 2.
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Task 3: Configuring the VTrak Appliance

Step 2: Setting up the Network
When you click the Next button in the Configure VTrak dialog box, the Network
Configuration dialog box appears. Several settings are made here:
*  Domain name — See page 17.
+  DNS server — See page 18.
+  Default gateway — See page 18.
*  NIC settings — See page 18.
+ Telnet — See page 19.
*+ FTP - See page 19.
* NTP - See page 19.
+  Finalize settings — page 19.
You can accept all default settings or make the required changes.

43 Network Configuration ]

Dormain narme: [

DMS {up ko bwao)

| () (o)

Defaulk gateway: | 192 . 188 . 253 . 1

R
[ Enable Telnet Enable FTP
[ allow root to log into kelnet session

Time Service: MTP

Adding a Domain Name
A domain name is optional. Appending the domain name is also optional.

To add a domain name:

1. In the Network Configuration dialog box, enter a domain name in the field
provided.

17
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2. If you entered a domain name and you want to append the suffix to the DNS
server, check the Append suffix to DNS lookup box.

Adding a DNS Server

If your network has Domain Name Server (DNS) and you want VTrak to work with

it, enter the DNS IP address here. You can have up to two DNS servers.

To add a new DNS:

1. Highlight one of the DNS servers and click the Delete button.
Click the Yes button to confirm.

2. Click the Add button and enter the IP address for a DNS server.

3. Inthe DNS (up to two) dialog box, enter the IP address of your DNS server
and click the OK button.

You return to the Network Configuration dialog box where the new DNS
appears in the list.
Specifying a Gateway

If your network has a gateway and you want VTrak to work with it, enter the
Gateway IP address in the Default gateway field.

Changing NIC Settings

An FC appliance (server) has four network ports, eth0 through eth3. An iSCSI
appliance has up to eight network ports, ethO through eth7. On all appliances,
eth0 is the management port. The default IP addresses are:

eth0 — 192.168.253.10 eth4 - 10.0.0.6
eth1-10.0.0.3 eth5 -10.0.0.7
eth2 - 10.0.0.4 eth6 — 10.0.0.8
eth3 -10.0.0.5 eth7 - 10.0.0.9

Obtain network setting information from your Network Administrator.

Caution

Network port eth0 is the management port.

In step 3 below, do NOT click the Delete button for network port
ethO.

Important

An IP address conflict among network ports eth? through eth3
prevents a High Availability configuration, even when those ports
are not connected.

18



Task 3: Configuring the VTrak Appliance

To change NIC (network) port settings:

1. Choose a NIC port from the dropdown menu and click the Config button.
The IP Address Configuration dialog box appears.

2. In the dialog box, choose a protocol,
*  DHCP - Automatic configuration by a DHCP server. Not recommended.
+  Static — Manual configuration. Recommended.

3. If you chose Static configuration, enter your IP address and subnet mask
settings.

* Add - Click the Add button and enter the IP address and subnet mask.

+ Edit — Highlight an IP address or subnet mask and click the Edit button
to modify them.

+  Delete — Highlight an IP address or subnet mask and click the Delete
button to delete them.

4. Accept the default Maximum Transmission Unit (MTU or frame) or enter a
new value.

1500 is the default and recommended value. 9000 (a jumbo frame) is the
maximum value.

5. When you are done making network settings, click the OK button.
You return to the Network Configuration dialog box.

Making Telnet Settings

Telnet is enabled by default. In most cases, Telnet is not appropriate for VTrak
because the protocol is not secure and difficult to use.

The recommended setting is to uncheck the Telnet box to disable Telnet.

If you want to use Telnet, see the VTrak S3000 User Manual on the software
DVD.

Making FTP Settings

FTP is enabled by default. FTP is used to flash firmware updates.
The recommended setting is to leave FTP box checked to enable FTP.
Configuring NTP Servers

The VTrak appliance has three default NTP servers. If you want to change the
NTP server configuration, see the VTrak S3000 User Manual on the software
DVD after the VTrak appliance is configured.

Finalizing Settings

When you are done making network settings, click the OK button.

The Configure VTrak dialog box appears, ready for Step 3.
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Step 3: Hosthame

Caution

If you plan to change the hostname, do so before you connect to
your storage devices.

If your storage is set up already and you change the hostname,
you must reconfigure your storage to recognize the new
hostname.

When you click the Next button in the Configure VTrak dialog box, the Warning
dialog box appears. At this phase of the system setup, you have no storage
configured. Therefore, the warning does not apply.

1. In the dialog box, click the OK button to continue.
The Set Hostname dialog box appears.

Flease enter the new hostname for this WTrak server

Present hostname: YTrak-01

MNew hostname:

Cancel [

2. Inthe dialog box, do one of the following actions:
»  Click the Cancel button to accept the Present (default) hostname.
*  Enter a new hostname for the VTrak appliance and click the OK button.

When you click the OK button, the network server automatically restarts.
That action drops your connection. Wait two to three minutes, then try to log
in. If you cannot log in, wait another minute and try again.

To see the new hostname as the Present hostname in the Set Hostname
dialog box, you must reboot the appliance.

When you log in, the Configure VTrak dialog box appears, ready for Step 4.
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Task 3: Configuring the VTrak Appliance

Step 4: IPMI Configuration

When you click the Next button in the Configure VTrak dialog box, the Configure
IPMI dialog box appears. There is only one channel, channel #1. The default
IPMI address is 192.168.253.101.

3 Configure IPMI

Please input IPMI card settings:

Channel #: 1 il

IF Address: | 192 . 168 . 253 . 101
Netmask: | 255 . 285 . 253 . 0
Defaul Gateway: | 192 . 168 . 253 . 1

In the dialog box, do any of the following actions:

»  Click the Cancel button to accept the default settings.
»  Click the Setting... button to view the default settings.
*  Make new IPMI settings.
To make new IPMI settings:
1. Enter all three settings, even if your setting is the same as the default.
» IP Address
+  Subnet Mask
+ Default Gateway IP address
2. Click the OK button.
The Configure VTrak dialog box appears, ready to finalize.
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Finalizing Configuration

When the Configure VTrak dialog box appears, you have a chance to review and
change your settings.

Configure ¥Trak

¥’ Step 1: Enter license keys done
¥  Step 2: Setup network done
¥ Step 3 Set hostname done
v’ Step 4: Configure IPMI done

[ Reset steps | | FinishﬂS

If any step shows skipped, or you want to review or change a previous
setting, click the Repeat steps button.

When you click the Repeat steps button, the configuration returns to Step 1
and goes through each step sequentially.

If all four steps show done and you are satisfied with your settings, click the
Finish button.

To quit the Management Console, choose File > Exit.

For more information about the Management Console, see the VTrak S3000
User Manual on the software DVD.

Note

If you have any unregistered licenses, when log into the VTrak
appliance, the Console Login dialog box appears.

Click the OK button to close the dialog box.

In the Tree, right-click the VTrak appliance and choose License
from the popup menu. Highlight the unregistered license and click
the Register button.

If you have an unregistered license:

1.
2.

Click the OK button to close the Console Login dialog box.

In the Tree, right-click the VTrak appliance (server) and choose License
from the popup menu.

The License Information dialog box appears.

In the License Information, highlight the unregistered license and click the
Register button.

For more information, see “Manual License Registration” on page 15.
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Task 4: Mounting the Subsystem in a Rack

Task 4: Mounting the Subsystem in a Rack

—

Cautions

At least two persons are required to safely lift, place, and
attach the VTrak unit into a rack system.

Do not lift or move the VTrak unit by the handles, power
supplies or the controller units. Hold the subsystem itself.

Do not install the VTrak unit into a rack without rails to support
the subsystem.

Only a qualified technician who is familiar with the installation
procedure should mount and install the VTrak unit.

Be sure all switches are OFF before installing the VTrak unit
or exchanging components.

Mount the rails to the rack using the appropriate screws and
flange nuts, fully tightened, at each end of the rail.

Do not load the rails unless they are installed with screws as
instructed.

The rails that ship with the PROMISE VTrak unit are designed
to safely support that PROMISE VTrak unit when properly
installed. Additional loading on the rails is at the customer’s
risk.

PROMISE Technology, Inc. cannot guarantee that the
mounting rails will support your PROMISE VTrak unit unless
you install them as instructed.

Note

To lighten the VTrak enclosure, remove the power supplies.
Replace the power supplies after the VTrak unit is mounted in your
rack.

The VTrak subsystem installs into your rack using the supplied mounting rails.
You can also use your existing rails.
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Figure 9. VTrak subsystem mounted in a rack with the supplied rails

Vertical Rack Post VTrak E610f/s

Attaching screw & flange nut
o Upper hole only

Handles mount Mounting rails (included) °
outside the rack post mount outside the rack postL®

To install the VTrak subsystem into a rack with the supplied mounting rails:
1. Check the fit of the mounting rails in your rack system.

See page 25, Figure 10.
2. Adjust the length of the mounting rails as needed.

The rear rail slides inside the front rail. The rail halves are riveted together
and use no adjustment screws.

3. Attach the mounting rail assemblies to the outside of the rack posts, using
the attaching screws and flange nuts from your rack system.

Be sure the front rail support is on the bottom facing inward.

The alignment pins fit into the rack holes above and below the attaching
screws.

Use the attaching screws and flange nuts from your rack system. Tighten the
screws and flange nuts according to your rack system instructions.

4. Place the VTrak subsystem onto the rails.
5. Secure the VTrak subsystem to the rack.

One screw each side, in the upper hole only. Use the attaching screws and
flange nuts from your rack system. Tighten the screws and flange nuts
according to your rack system instructions.
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Task 4: Mounting the Subsystem in a Rack

Figure 10. Subsystem rack mount assembly diagram

Rack front post ) ) Rack rear post
Alignment pins
two on each flange l

Front rail Rear rail
/ Support for \
Q subsystem

©
/

N\

Inside of post Rail attaching screws Inside of post
(not included)

Note that only the front rail has a support for the subsystem.
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Task 5: Installing Disk Drives in the Subsystem
The VTrak appliance ships with physical drives already installed in the chassis.
VTrak RAID subsystems and JBOD enclosures ship without physical drives.

For optimal performance, use physical drives of the same model and capacity.
when you create an array. The physical drives’ matched performance allows the
logical drive to function better.

The table below shows the number of subsystem drives required for each RAID

level.
Level Number of Drives Level Number of Drives
RAID 0 1 or more RAID 6 4 to 32
RAID 1 2 only RAID 10 4 or more*
RAID 1E 2 or more RAID 50 6 or more
RAID 5 3to 32 RAID 60 8 or more
* Must be an even number of drives.

Drive Slot Numbering

The diagram below shows how VTrak’s drive slots are numbered. Slot numbering
is reflected in the WebPAM PROe and CLU user interfaces.

Figure 11. VTrak subsystem drive slot numbering

Install all of the drive carriers into the VTrak enclosure to ensure proper airflow,
even if you do not populate all the carriers with disk drives.
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Task 5: Installing Disk Drives in the Subsystem

Caution

VTrak supports disk drive hot-swapping. To avoid hand contact
with an electrical hazard, do not remove more than one drive
carrier a time.

Important

If your subsystem has SATA disk drives, an AAMUX adapter is
installed in the carrier with each drive.

Your VTrak subsystem has dual RAID controllers. But SATA drives
have only one data channel. The AAMUX adapter provides a
second data channel so both RAID controllers can access the
SATA drive.

Replacement AAMUX adapters are available from PROMISE
Technology.

SAS disk drives have two data channels and do not require
AAMUX adapters.
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Task 6: Making Data Connections

Connecting the RAID Subsystem

The VTrak RAID subsystem connects to the VTrak appliance using a Fibre
Channel (FC) or a SAS data connection.

Fibre Channel Interface
The VTrak FC subsystem uses four (4) 8-Gb SFP+ transceivers, two per RAID
controller on its two FC ports.

SAS Expansion Port

\
- o3 oE I
Q Q ® (O]
299 810010- G

Gbis. 11200

FC Port 1 FC Port 2

To connect the FC subsystem:

1. Connect one of the FC ports on the left RAID controller to one of the
downstream FC ports on the HBA card in the VTrak appliance.

2. Connect one of the FC ports on the right RAID controller to one of the
downstream FC ports on the HBA card in the VTrak appliance.

See the diagram below.
FC downstream card
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SAS Interface

The VTrak SAS subsystem has two SAS IN ports and two SAS OUT ports on
each RAID controller. The connection requires two (2) SAS SFF-8088 to SFF-
8088 cables, available from PROMISE.

SAS Expansion Port

\ SAS 1/O Port SAS /O Port
\ /

\ VY ¥4
_= \O o) N7 R4 o) Ll o0 UPS
coo wmm oo N &
PN

O HEmENm O©
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B0

SAS I/O Port SAS /O Port

To connect the SAS subsystem:

1. Connect one of the SAS I/O ports on the left RAID controller to one of the
downstream SAS ports on the HBA card in the VTrak appliance.

2. Connect one of the SAS 1I/O ports on the right RAID controller to one of the
downstream SAS ports on the HBA card in the VTrak appliance.

See the diagram below.
SAS downstream card
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Connecting the PC Workstation

To connect the PC workstation:
Connect the FC HBA card in the PC workstation to the FC switch.
See the diagram, below.
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FC

7N\

NY/

®
=
® O

o D o
o@Boo@o l & oo

workstation

©0000000000000000000000000000000000000000000000000000000000

switch

00 60 00 00 00 00 00 00 00 00 60 00 00 00 00 0O
Wy
|

—

|

FC HBA card
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Connecting the VTrak Appliance
Upstream connections to VTrak appliance are either:

*  Fibre Channel Interface (page 31)
* iSCSI Interface (page 32)

Fibre Channel Interface

A Fibre Channel (FC) upstream configuration is commonly used in VMware,
Microsoft Exchange, and Microsoft SQL environments.

To connect the VTrak appliance:

Connect one or both upstream FC ports on the VTrak appliance to the FC
switch.

See the diagram, below.
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00 00 00 00
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FC switch
FC upstream card

VTrak appliance
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iSCSI Interface

An iSCSI upstream configuration is commonly used in Linux, Apache, MySQL,
PHP or Python (LAMP) environments. The iISCSI data connection is totally
separate from the network management connection, described on page 36.

Be sure that your network switch matches speed of the iSCSI HBA card in the
VTrak appliance. Whenever possible, iSCSI data should have a dedicated
network.

If you connect multiple network ports, you can implement IP bonding (port
aggregation) for a higher bandwidth data connection. For more information, see
Chapter 17 of the VTrak S3000 User Manual.

To connect the VTrak appliance:

* Gigabit iSCSI — Connect one or more upstream data ports in the VTrak
appliance to your network switch. Six (6)1-Gb/s data ports are available. See
the diagram, below.

: T o e S
0000000000000 000
8590000000000000 !!%l!! J G NP R
0000000000000 000O

Gb network switch 2-port iSCSI HBA card

VTrak appliance
4-port iSCSI
upstream card

* 10 Gigabit iSCSI — Connect one or both upstream data ports in the VTrak
appliance to your network switch. There two 10-Gb/s data ports. The 1-Gb/s
iSCSI HBA card is not used. See the diagram, below

00 00 00 0O 00 0O 00 00 0O OO OO 0O 0O 0O OO0 0O 00 OO 00 QO 0O 00

10 Gb network switch 2-port, 10-Gbls iSCS|
upstream card
/

VTrak appliance
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SAS Expansion Connections (Optional)

You can expand the storage capacity of the VTrak RAID subsystem by adding
VTrak JBOD enclosures. Connecting a pair of subsystems requires two (2) SAS
SFF-8088 to SFF-8088 cables, available from PROMISE.

A VTrak RAID subsystem supports up to four (4) VTrak JBOD enclosures.

To connect the VTrak RAID subsystem to a VTrak JBOD enclosure:

1.

Connect a SAS cable from the Expansion port on the /left RAID controller to
the SAS IN port on the /eft I/O module.

Connect a SAS cable from the Expansion port on the right RAID controller to
the SAS IN port on the right 1/0O module.

See the diagram below.

To connect one VTrak JBOD enclosure to another VTrak JBOD enclosure:

1.

Connect a SAS cable from the SAS OUT port on left I/O module to the SAS
IN port on the /eft /O module.

2. Connect a SAS cable from the SAS OUT port on right |/O module to the SAS
IN port on the right 1/O module.
See the diagram below.
SAS Expansion port RAID controller
VTrak
RAID
SAS OUT por’( 1/0 module
0
= VTrak
5=
L «@g@ JBOD 1
m %
SAS IN port
VTrak
JBOD 2
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Task 7: Making Management Connections

Connecting the RAID Subsystem

The management connection is the same for Fiber Channel and SAS VTrak

subsystems.

To connect the RAID subsystem:
1. Connect the Management port on the /eft RAID controller to your network

switch.

2. Connect the Management port on the right RAID controller to your network

switch.

See the diagram, below.
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Network switch

)

— @

VTrak RAID subsystem

Note

If you are adding a VTrak JBOD enclosure, the JBOD is managed
by the RAID controller on the RAID subsystem, though the SAS
connection.

There is no management connection to JBOD enclosures.
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Connecting the PC Workstation
To connect the PC workstation:

Connect the network port on the PC to your network switch.
See the diagram, below.
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Connecting the VTrak Appliance

The network management connection is totally separate from the iSCSI data
connection, described on page 32.
To connect the VTrak appliance:

1. Connect one of the network ports on the VTrak appliance to the network
switch.

2. Optional. Connect the other network port on the VTrak appliance to the
network switch.

See the diagram, below.

[ ) e o
0000000000000 000
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0000000000000000

Network switch

IPMI port Management port

VTrak appliance

Important

If you are using Intelligent Platform Management Interface (IPMl),
connect to the dedicated IPMI port, rather than one of the network
ports. For more information, see the Embedded BMC IPMI User
Guide included with the VTrak appliance documentation.
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Task 8: Setting-up Serial Cable Connections

Serial communication enables the Command Line Interface (CLI) and Command
Line Utility (CLU) on your PC to monitor to control the VTrak. The VTrak package
includes one RJ11-to-DB9 serial data cable for each controller. All VTrak models
have the same serial connection.

Figure 12. Serial and UPS connectors are located on the controller

RJ11 Serial DB9 UPS
connector connector

To set up a serial cable connection:
1. Attach the RJ11 end of the serial data cable to the RJ11 serial connector on
one of the controllers.

2. Attach the DB9 end of the serial data cable to a serial port on the Host PC or
server.

Optional UPS Serial Connection

If your deployment plan calls for one or more UPS units and management via
serial communication, connect the UPS control cable to the DB9 connector on
the VTrak controller. See Figure 12.

When your subsystem is running, see “Making UPS Settings” in the VTrak E-
Class Product Manual on the software DVD to complete the UPS management
setup.
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Task 9: Powering-on the Subsystem

Plug the power cords and turn on the switches on both power supplies.

Important

Always power on the JBOD enclosures first. Then power on the
RAID subsystem.

When the power is switched on, the LEDs on the front of the VTrak light up.
Figure 13.VTrak front panel LED display

- Power

jl«— FRU Status

- Logical Drive Status

-— Controller-1 Activity

)| <«— Controller-2 Activity

~————— Controller Heartbeat

When boot-up is finished and the VTrak is functioning normally:

«  Controller LED blinks green once per second for five seconds, goes dark for
ten seconds, then blinks green once per second for five seconds again.

+ Power, FRU and Logical Drive LEDs display green continuously.
+  Controller LEDs flash green if there is activity on that controller.

There are two LEDs on each disk drive carrier. They report the presence of
power and a disk drive, and the current condition of the drive.
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Figure 14.VTrak disk drive carrier LEDs
Disk Status

\

Power/Activity

After a few moments the Power/Activity LED should display Green. If there is no
disk drive in the carrier, the Power/Activity LED remain dark.

The Power/Activity LED flashes during drive activity.

The Disk Status LED displays Green when a drive is present and configured.
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Task 10: Setting-up the Subsystem

Setting up the subsystem consists of the following actions:
+  Setting up the Serial Connection (below)

*  Choosing DHCP or a Static IP Address (page 40)

*  VTrak Default IP Addresses (page 41)

»  Setting up VTrak with the CLI (page 41)

»  Setting up VTrak with the CLU (page 43)

Setting up the Serial Connection

VTrak has a Command Line Interface (CLI) to manage all of its functions,
including customization. A subset of the CLI is the Command Line Utility (CLU), a
user-level interface that manages your VTrak via your PC’s terminal emulation
program, such as Microsoft HyperTerminal. This procedure uses the serial cable
connection you made. See “Task 8: Setting-up Serial Cable Connections” on
page 37.

1. Change your terminal emulation program settings to match the following
specifications:

»  Bits per second: 115200

+ Data bits: 8

*  Parity: None

»  Stop bits: 1

*  Flow control: none

Start your PC’s terminal VT100 or ANSI emulation program.

Press Enter once to launch the CLI.

At the Login prompt, type administrator and press Enter.

o wbd

At the Password prompt, type password and press Enter.

At this point, you are in the CLI. You can continue using the CLI to make
network settings or you can switch to the CLU. Go to:

«  Setting up VTrak with the CLI (page 41)
+  Setting up VTrak with the CLU (page 43)

Choosing DHCP or a Static IP Address

When you set up your VTrak, you have the option of:

+  Enabling DHCP and letting your DHCP server assign the IP address to the
VTrak’s virtual management port.

+  Specifying a static IP address for the VTrak’s virtual management port.
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If you choose to enable DHCP, have your Network Administrator dedicate an IP

address for the VTrak, linked to the VTrak’'s MAC address. This action prevents

the DHCP server from assigning a new |IP address when the VTrak restarts, with
the result that users can no longer log in.

To access the MAC address for VTrak’s virtual management port:

* Inthe CLI, type net -v and press Enter.

* Inthe CLU Main Menu, highlight Network Management and press Enter.
Then highlight Virtual and press Enter.

VTrak Default IP Addresses

VTrak uses virtual and physical IP addresses. This arrangement enables you to
access a VTrak with two RAID controllers over your network using a single IP
address.

Virtual Management Port

The default virtual management port IP address is set to 10.0.0.1.

Use the virtual management port IP address to log into the VTrak over your
network. See “Logging into WebPAM PROe” on page 46.

Physical Management Ports

The default physical management port IP addresses are set to:

+  Controller 1-10.0.0.2

+  Controller 2 -10.0.0.3

Use the physical management port IP address only when a controller is in

maintenance mode. See the VTrak E-Class Product Manual on the software DVD
for more information.

Setting up VTrak with the CLI

To set the system date and time, type the following string and press Enter.
administrator@cli> date -a mod -d 2010/06/25 -t 14:50:05

In the above example, the date and time are included as examples only. Your
values will be different. Use yyyyy/mm/dd for the date and a 24-hour clock for the
time.

Making Virtual Port Settings

1. To make the Virtual Management Port network settings manually, type the
following string and press Enter.

administrator@cli> net -a mod -t mgmt -s camers
primaryipmask=255.255.255.0, gateway=192.168.10.1"
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The settings above are included as an example. Your values will be different.
To make the Virtual Management Port network settings automatically, type
the following string, then press Enter.

administrator@cli> net -a mod -t mgmt -s "dhcp=enable”
Note that the IP address described above belongs to the VTrak subsystem,
not to an individual RAID controller. Use this IP address to log into the VTrak
over your network.

2. To verify the settings, type net and press Enter.
administrator@cli> net

Virtual Mgmt 192.168.10.85 255.255.255.0 192.168.10.1 Up

Making Maintenance Mode Settings

Each RAID controller has an IP addresses for access when the controller
goes into maintenance mode. Maintenance mode is only for remedial action
in the event of a problem with one of the controllers. See the VTrak E-Class
Product Manual on the software DVD for more information.

1. To make the Maintenance Mode Network settings manually, type the
following string and press Enter.
You must set each controller separately.

administrator@cli> net -a mod -t mgmt -m -c 1 -s
"primaryip=192.168.10.101, primaryipmask=255.255.255.0,
gateway=192.168.10.1"

administrator@cli> net -a mod -t mgmt -m -c 2 -s
"primaryip=192.168.10.102, primaryipmask=255.255.255.0,
gateway=192.168.10.1"

The settings above are included as an example. Your values will be different.

To make the Maintenance Mode Network settings automatically, type the
following strings and press Enter.
You must set each controller separately.

administrator@cli> net -a mod -t mgmt -m -c 1 -s "dhcp=enable"
administrator@cli> net -a mod -t mgmt -m -c 2 -s "dhcp=enable"

Note that the network settings above belong to individual RAID controllers.
Use these IP addresses only for remedial action when the subsystem is in
maintenance mode.

42



Task 10: Setting-up the Subsystem

2.
administrator@cli> net -m

Ctrild: 1

Type: Management Ethernet
IP: 192.168.10.101

MAC: 00:01:55:AE:02:AE
Gateway: 192.168.10.1

To verify the maintenance mode settings, type net -m and press Enter.

Port: 1

IPType: IPv4

IPMask: 255.255.255.0
DNS: 0.0.0.0

DHCP: Disabled

This completes the Management port setup. Go to “Task 11: Configuring Storage
on the Subsystem” on page 46.

To see the full set of CLI commands, at the admin@cli> prompt, type help and
press Enter.

Setting up VTrak with the CLU

1. At the administrator@cli> prompt, type menu and press Enter.
The CLU main menu appears.

Figure 15.CLU main menu
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2. With Quick Setup highlighted, press Enter.

The first Quick Setup screen enables you to make Date and Time settings.
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Setting system date and time

1. Press the arrow keys to highlight System Date.
Press the backspace key to erase the current date.
Type the new date.

Follow the same procedure to set the System Time.

ok owbd

Press Ctrl-A to save these settings and move to the Management Port
configuration screen.

Making Management (Virtual) Port Settings Manually

To make Management Port settings manually:

1. Press the arrow keys to highlight /P Address.

2. Press the backspace key to erase the current IP Address.

3. Type the new IP Address.
4

Follow the same procedure to specify the Subnet Mask, Gateway IP
Address and DNS server IP Address.

If you do not have a DNS server, skip the DNS server IP address.
5. Press Ctrl-A to save your settings.

Making Management (Virtual) Port Settings Automatically
To make Management Port settings automatically:

1. Press the arrow keys to highlight DHCP.

2. Press the spacebar to toggle to Enable.

3. Press Cirl-A to save these settings.

Viewing Management (Virtual) Port Settings

To view the current IP address and network settings when using DHCP:

1. Press the arrow keys to highlight DHCP.

2. Press the spacebar to toggle to Disable.
The current Management Port settings are displayed.

3. Press the spacebar to toggle DHCP back to Enable.

4. Press Ctrl-A to save these settings and move to the RAID configuration
screen.

Making Controller Maintenance Mode Settings

Each RAID controller has an IP addresses for access when the controller goes
into maintenance mode. Maintenance mode is only for remedial action in the
event of a problem with the controller. See the VTrak E-Class Product Manual on
the software DVD for more information.
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Making Automatic Settings

e

From the CLU Main Menu, highlight Network Management and press Enter.
Highlight Maintenance Mode Network Configuration and press Enter.
Highlight the controller you want and press Enter.

Highlight DHCP and press the spacebar to toggle to Enabled.

Press Ctrl-A to save your settings.

Making Manual Settings

1.

ok wbd

6.

From the CLU Main Menu, highlight Network Management and press Enter.
Highlight Maintenance Mode Network Configuration and press Enter.
Highlight the controller you want and press Enter.

Highlight DHCP and press the spacebar to toggle to Disabled.

Highlight each of the following and press the backspace key to erase the
current value, then type the new value.

+ |P Address

*  Subnet Mask

+  Default Gateway IP Address
* DNS server IP Address
Press Ctrl-A to save your settings.

Exiting the CLU

1.
2.

Highlight Skip the Step and Finish and press Enter.
Highlight Return to CLI and press Enter.

This completes the Management Port setup. Go to “Task 11: Configuring Storage
on the Subsystem” on page 46.
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Task 11: Configuring Storage on the Subsystem

Setting up your subsystem with WebPAM PROe consists of the following actions:
*  Logging into WebPAM PROe (below)

*  Choosing a Language (page 48)

+  Making Subsystem Settings (page 48)

* Restarting the Subsystem (page 48)

*  Making Controller Settings (page 49)

*  Making Background Activity Settings (page 49)

+  Making Global Physical Drive Settings (page 50)

*  Making Individual Physical Drive Settings (page 50)
»  Configuring your Logical Drives (page 50)

*  Logging out of WebPAM PROe (page 53)

Logging into WebPAM PROe

1. Launch your Browser.

2. In the Browser address field, type in the virtual IP address of the VTrak
subsystem.

Use the virtual IP address you set in the CLI (page 41) or CLU (page 43).
Note that the IP address shown below is only an example. The IP address
you type into your browser will be different.

Regular Connection
*  WebPAM PROe uses an HTTP connection. . .............. http://
+ EntertheVTrak'sIPaddress................... 192.168.10.85
Together, your entry looks like this:

http://192.168.10.85

Secure Connection

*  WebPAM PROe uses a secure HTTP connection. . ........ https://
« EntertheVTrak'sIPaddress................... 192.168.10.85
Together, your entry looks like this:

https://192.168.10.85

Note
Whether you choose a regular or a secure connection, your login

to WebPAM PROe and your user password are always secure.

46



Task 11: Configuring Storage on the Subsystem

3.  When the log-in screen appears:

«  Type administrator in the User Name field.

+  Type password in the Password field.

»  Click the Login button.

The User Name and Password are case sensitive.
4. Click the Login button.

Figure 16. WebPAM PROe log-in screen
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After sign-in, the WebPAM PROe opening screen appears. If there are any
unconfigured physical drives in the enclosure, an Array Configuration menu also
appears. See page 51, Figure 19.

Note

Make a Bookmark (Firefox) or set a Favorite (Internet Explorer) of
the Login Screen so you can access it easily next time.
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Choosing a Language
WebPAM PROe displays in English, German, French, Italian, Japanese, Korean,
Traditional Chinese, and Simplified Chinese.
1. Click Language on the WebPAM PROe Header.
The language list appears in the Header.
2. Click the language you prefer.
The WebPAM PROe user interface displays in the chosen language.

Figure 17.Clicking “Language” on the WebPAM PROe Header
| Lan?ﬂ!ge | View | Storage Network | ContactUs | Logout | Help | About |

Making Subsystem Settings
To make the recommended settings to the subsystem:

Click the Subsystem £&# icon in Tree View.

Click the Settings tab in Management View.

In the Redundancy Type dropdown menu, choose Active-Active.
Check the Cache Mirroring box to enable.

Click the Submit button.

Restart the subsystem.

2R

See “Restarting the Subsystem, below.
Restarting the Subsystem

Note

You are not required to restart the JBOD enclosures when you
restart the RAID subsystem.

To restart the RAID subsystem:

1. Click the Subsystem E# icon in Tree View.

Click the Administrative Tools &4 icon.

Click the Shutdown link in Management View.

On the Shutdown or Restart tab, choose Restart from the Option menu.
Click the Submit button.

In the confirmation box, type the word confirm in the field provided and click
the OK button.

2B
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When the controller shuts down, your WebPAM PROe connection is lost.
Wait about two minutes.

In your browser, click Logout in the Header, then log into WebPAM PROe
once again.

If you cannot log in, wait 30 seconds and try again.

Making Controller Settings

Your subsystem has two controllers. Settings you make to one controller are
automatically applied to the other controller.

To make the recommended controller settings:

1.

o ke DN

Click the Subsystem E# icon in Tree View.
Click the Controllers "l icon.

Click the Controller "] icon.

Click the Settings tab in Management View.

Make the following settings:

*  UNcheck the Enable LUN Affinity box to disable.

*  UNcheck the Enable SMART Log box to disable.

*  Check the Adaptive Writeback Cache box to enable.
*  UNcheck the Host Cache Flushing box to disable.

*  UNcheck the Forced Read Ahead [cache] box to disable.
Leave the other settings at their default values.

Click the Submit button.

The changes take effect immediately.

Making Background Activity Settings

To make the recommended background activity settings:

1.
2.
3.

Click the Subsystem E# icon in Tree View.
Click the Controllers "l icon.

Click the Controller "/ icon.

From the dropdown menu on the Background Activities tab, choose
Settings.

Check the Enable Auto Rebuild box to enable.
Leave the other settings at their default values.
Click the Submit button.

The changes take effect immediately.
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Making Global Physical Drive Settings

To make the recommended physical drive settings:

o oA wh ==

7.
8.

Click the Subsystem &g icon in Tree View.

Click the Enclosures & icon.

Click the Enclosure & icon of the Head Unit.

Click the Physical Drives il icon.

Click the Global Settings tab in Management View.
Check the boxes to enable:

+  Enable Write Cache

+ Enable Read Look Ahead Cache

In the Medium Error Threshold field, type 64.

Click the Submit button.

Making Individual Physical Drive Settings

To make the recommended physical drive settings:

BN O

® N

Click the Subsystem E# icon in Tree View.
Click the Enclosures & icon.

Click the Enclosure & icon of the Head Unit.
Click the Physical Drives il icon.

Click a Physical Drive B icon.

From the dropdown menu on the SMART Log tab, choose Settings.
Management View.

UNcheck the SMART box to disable:
Click the Submit button.
Repeat these steps for all of your physical drives.

Configuring your Logical Drives

Note

For an explanation of disk array and logical drive parameters, see
the VTrak E-Class Product Manual on the software DVD.

On a newly activated VTrak subsystem, there are no disk arrays or logical drives.
You must create them. The recommended configuration looks like this:
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Figure 18.Recommended logical drive configurations

VTrak RAID subsystem or JBOD enclosure

You create disk arrays one at a time. You can create multiple logical drives at the
same time on the same disk array.

Important

If you plan to set up High Availability (HA), create one logical drive
of at least 12 GB capacity to serve as a dedicated LUN.

See “Task 13: Setting-up High Availability” on page 62.

To create your disk arrays and logical drives:

1. Click the Disk Arrays E
The Array Configuration menu appears.

#| icon, then click the Create tab.

Figure 19.The Array Configuration menu

Array Configuration - 4 unconfigured physical drives in the subsystem.

Information | Create « | Delete

&2 Configuration Method

O Automatic Configuration (User has no choice. Only one logical drive is created.)
O Express Configuration (User has some choices. All logical drives are the same.)

@ Advanced Configurstion (User has full selection. Each logical drive can be different.)

2. Choose the Advanced option and click the Next button.
The Step 1 — Disk Array Creation screen displays.

Step 1 — Disk Array Creation
1. Enter a name for the disk array in the field provided.
For recommended names, see page 51, Figure 18.

Maximum of 31 characters; letters, numbers, space between characters, and
underline.
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2. Check the boxes to enable Media Patrol, PDM, or Power Management.
3. Choose the Physical Drives Type from the dropdown menu.

+ HDD - Hard Disk Drives

+ SSD - Solid State Drive

You cannot mix HDDs and SSDs in the same array.

4. Highlight physical drives you want in the disk array from the Available list and
press the >> button to move them to the Selected list.

You can also double-click them to move them.
For the recommended number of drives, see page 51, Figure 18.

Note

If you have more physical drives than the eight (8) that come with
the system, you can use them to create additional disk arrays and
logical drives.

5.  When you are done, click the Next button.

Step 2 - Logical Drive Creation

1. Enter an alias for the logical drive in the field provided.
For recommended aliases, see page 51, Figure 18.

2. From the RAID Level dropdown menu,
«  Forall logical drives choose RAID 5

* RAID levels are based on the number of physical drives chosen for each
disk array. See page 51, Figure 18.

3. Leave the logical drive size at the default maximum value.
4. For the following items, accept the default values in the dropdown menu:
«  Stripe size — 64 KB is the default.
»  Sector size — 512 B is the default.
* Read (cache) Policy — Read Ahead is the default.
*  Write (cache) Policy — Write Back is the default.
+  Preferred Controller ID — Automatic is the default.
5. Click the Update button.
A new logical drive is displayed under New Logical Drives.
6. Click the Next button.

Step 3 — Summary
The Summary lists the disk array and logical drive information you specified.
To proceed with disk array and logical drive creation, click the Submit button.
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Important

*  You must partition and format your logical drives to work with
your operating system.

*  Make the two DATA logical drives Service-Enabled.

For more information, see Chapter 5 of the VTrak S3000 User
Manual on the software DVD.

Creating Spare Drives
Create two global spare drives in the RAID subsystem.
To create a spare drive:
1. Click the Subsystem E# icon in Tree View.

Click the Spare Drives &l icon.

Click the Create tab in Management View.
Choose the Global spare type.

Check the Revertible box.

In the Physical drives field, highlight the physical drive you want to assign as
a spare drive in the Available list and press the >> button to move the drive
to the Selected list.

You can also double-click drives to move them.
7. Click the Update button.

Your choices are displayed under New Hot Spare Drives.
8. Click the Submit button.

o ok

Logging out of WebPAM PROe

There are two ways to log out of WebPAM PROe:
*  Close your browser window
»  Click Logout on the WebPAM PROe banner

Figure 20.Clicking “Logout” on the WebPAM PROe banner

| Language | View | Storage Network | ContactUs | Lu?iul | Help | About |

Clicking Logout brings you back to the Login Screen. See page 47.

After logging out, you must enter your user name and password in order to log in
again.
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Task 12: Setting-up Basic Storage

Use the PROMISE Management Console to set up your storage. The word
storage refers to a LUN or logical drive on your VTrak RAID subsystem or JBOD
enclosure.

For basic storage, there are five steps.

1. Discover the storage.

Virtualize the storage.

Create a logical resource.

Create a SAN client, either Fibre Channel or iSCSI.
Assign storage to the SAN client.

ok owbd

Before You Begin

Before you begin setting up your storage, verify that:

*  You are logged into the Management Console. See “Logging into the
Management Console” on page 9.

« There is at least one logical drive on the VTrak subsystem. See “Configuring
your Logical Drives” on page 50.

Discovering the Storage
To discover the storage:

In the Tree, expand a SCSI 2 adapter or Fibre Channel m adapter to
discover your LUN.

If the LUN does not appear, right-click the Physical Adapters & icon and
choose Rescan from the popup menu.

Virtualizing the Storage

To virtualize the storage:

1. In the Tree, under Physical Devices ‘g, SCSI Devices &l or Fibre Channel
Devices &, right-click a LUN and choose Properties from the popup menu.
The Disk Preparation dialog box opens.

2. Inthe dialog box, choose Reserve for Virtual Device from the dropdown
menu and click the OK button.

The Warning (data loss) dialog box opens.
3. Inthe dialog box, type yes in the field provided and click the OK button.
The Success dialog box opens.
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4.

In the dialog box, click the OK button.

The device icon changes from no letter &l to V .

Creating a Logical Resource

To create a logical resource:

1.

7.

In the Tree, under Logical Resources J click SAN Resources and choose
New from the popup menu.

The Create SAN Resources wizard opens.

In the wizard, click the Next button.

The Select SAN Resource dialog box opens.

In the dialog box, click the Virtual Device option and click the Next button.
The Select Physical Resources for the Virtual Device(s) dialog box opens.

In the dialog box, check the Virtual Device or Devices you want and click
the Next button.

The Thin Provisioning Option dialog box opens.

See Chapter 5 of the VTrak S3000 Server User Manual for more information
about Thin Provisioning.

In the dialog box, enter the resource size in MB you want in Full Disk Size
field.

The range of available disk sizes is shown. Click the Next button to continue.
The Select Creation Method dialog box opens.

In the dialog box, choose a creation method:

*  Custom - For advanced users

*  Express — Required for Thin Provisioning

+  Batch - For creating multiple SAN resources of the same size

If you chose Express, enter the initial disk size in MB into the Size to Allocate
field. The range is 10 MB to 99% capacity of the full disk size.

Click the Next button to continue.
The next dialog box depends on your choice of creation method.

Custom

If you chose Custom, the Select a Physical Device dialog box opens.
Click the Device you want to use and click the Next button.

Express

If you chose Express, the Enter the SAN Resource Name dialog box opens.
Enter a name for your SAN resource in the field provided.
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Batch

9.

If you chose Batch, the Specify Batch Mode Information dialog box opens.

*  Accept the default a SAN Resource Prefix or enter a new one in the field
provided.

*  Enter a Resource Size in MB if the field provided.

*  Enter the Starting Number and the Number of (SAN) Resources in the
fields provided.

»  From the list, click the Device you want to use and click the Next button.
The SAN Resource Name dialog box opens.

In the dialog box, enter a name for the SAN resource in the field provided
and click the Next button.

The Create the SAN Resource dialog box opens.
In the dialog box, verify the information and click the Finish button.

10. In the success message, click

*  Yes — Assign SAN clients now.
*  No - Assign SAN clients later.

Enabling a FC Target Mode

You must enable FC target mode on the appliance (server) before you can create
an FC SAN client.

To enable FC target mode:

1.

In the Tree, right-click the VTrak server @ icon and choose Options >
Enable FC Target Mode from the popup menu.

In the Tree, go to Server > Physical Resources > Physical Adapters.

Right-click the Fibre Channel I adapter to be used for the UPstream
connection and choose Enable FC Target Mode from the popup menu.

Creating a FC SAN Client

To create a Fibre Channel SAN client:

1.

In the Tree, right-click SAN Clients i icon and choose Add from the popup
menu.

The Add Client wizard opens.
Click the Next button to continue.
The Select Client Protocols dialog box opens.

In the dialog box, check the Fibre Channel protocol used to connect your
clients’ PCs to the VTrak appliance.
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Click the Next button to continue.

Either the Set Client Fibre Channel Properties or the Set Client iSCSI
Properties dialog box opens.

In the dialog box, click Add button.
The Add Initiator WWPN dialog box opens.

In the dialog box, enter your initiator WWPN and click the OK button to
continue.

The Set Client Properties dialog box opens with the initiator WWPN in the
list.

The next step depends on your choice of action.
. To add another WWPN, click the Add button.

. To choose the WWPNs you want to use, check the box beside each
one.

«  To continue, click the Next button.

The Enter the Generic Client Name dialog box opens.
In the dialog box,

«  Enter a client name into the field provided.

*  Choose the Client Type from the dropdown menu.

*  Check Is Clustered box if you plan to assign the same storage to
multiple clients.

« Ifthe Client PC is running, click the Find button to discover it. If the PC
is found, its IP address is input automatically.

. If the Client PC is offline, enter the IP address manually.
Click the Next button to continue.

The Fibre Channel Options dialog box opens.

In the dialog box, click the Next button to continue.

VTrak does not support VSA.

The Select Persistent Reservation Option dialog box opens.

In the dialog box, uncheck the box to disable the Persistent Reservation
feature, and click the Next button.

Persistent Reservation applies to clustering applications.
The Add the Client dialog box appears.
In the dialog box, verify the information and click the Finish button.

The new client ([ appears in the Tree under SAN Clients "3
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Creating an iSCSI SAN Client
To create an iSCSI SAN client:

1.

In the Tree, right-click the VTrak server @ icon and choose Options >
Enable iSCSI from the popup menu.

In the Tree, right-click SAN Clients 'i[d and choose Add from the popup
menu.

The Add Client wizard opens.
Click the Next button to continue.
The Select Client Protocols dialog box opens.

In the dialog box, check the iISCSI protocol used to connect your clients’ PCs
to the VTrak appliance.

Leave the Create default iSCSI target box checked.
Click the Next button to continue.
The Select Target IP dialog box opens.

In the IP Address list, check the box next to the IP address of the iSCSI
targets you want to add.

Click the Next button to continue.
The Set Client’s Initiator dialog box opens.

In the dialog box, check the box next to the Initiator Name of the iSCSI
clients you want.

Choose any iSCSI initiator with a green icon.
A yellow icon means that initiator is already assigned to a different client.
Click the Next button to continue.
The Set iSCSI User Access dialog box opens.
In the dialog box, choose an option,
*  Allow unauthenticated access
»  Select servers who can authenticate for the client
With the Select servers option, choose,
*  Default CHAP secret
*  Mutual CHAP secret

If you chose the default secret, enter a CHAP secret of 12 to 16
characters in the field provided.

Enter the CHAP again in the Confirm field.

If you chose mutual secret enter a CHAP secret and a Mutual CHAP
secret of 12 to 16 characters each in the fields provided.
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Enter the CHAP secret and Mutual CHAP secret again in the Confirm
fields.

Click the Next button to continue.

The Enter the Generic Client Name dialog box opens.
In the dialog box,

*  Accept the default client name or enter a new one.

*  From the Client Type dropdown menu, choose the client’s operating
system.

*  Check Is Clustered box if you plan to assign the same storage to
multiple clients.

»  Click the Find button to automatically load the client’s IP address. Or
enter it manually.

Click the Next button to continue.
The Select Persistent Reservation Option dialog box opens.
In the dialog box,

» Leave the Persistent Reservation box checked if you plan to assign
the same storage to multiple clients.

* Uncheck the Persistent Reservation box if you do NOT plan to assign
the same storage to multiple clients.

Click the Next button to continue.
The Verify Client Information dialog box appears.
In the dialog box, verify the information and click the Finish button.

The new client ([H| appears in the Tree under SAN Clients "3

Assigning Storage to an FC Client

To assign storage to an FC client:

1.

In the Tree, under SAN Clients 'ild, right-click a Fibre Channel client [, and
choose Assign from popup menu.

The Assign a Client wizard opens.

Click the Next button to continue.

The Select SAN Resource(s) dialog box opens.

In the dialog box, check the box by storage you want to use.

If the SAN resource you are assigning is in a group, and you want to assign
all resources in the group to this client, check the Assign all the group
members box.

Click the Next button to continue.

59



VTrak S3000 Quick Start Guide

The Select a WWPN Port Mapping Type dialog box opens.

In the dialog box, choose the appropriate mapping type for your system.
*  One to One — You do not use multipathing.

«  All to All — You use multipathing, such as PerfectPath on Windows.
Click the Next button to continue.

The Select Initiator dialog box opens.

In the dialog box, click the Initiator WWPN you want to use.

You can only choose one. Click the Next button to continue.

The Select Target dialog box opens.

In the dialog box, click the Target WWPN you want to use.

You can only choose one. Click the Next button to continue.

The Select LUN numbers for the resources dialog box opens.

In the dialog box, choose a Starting LUN from the menu.

The default LUN number is O (zero).

Important

If you checked Is Clustered when you created the SAN client, be
careful that you do NOT assign the same LUN to different SAN
resources.

Click the Next button to continue.

The Assign SAN Resource(s) to the SAN Client dialog box opens.
In the dialog box, verify the information and click the Finish button.
A success message displays.

In the message, click the OK button.

The new SAN resource @ appears in the Tree under the SAN client [ to
which you assigned it.

Assigning Storage to an iSCSI Client

To assign storage to an iSCSI client:

1.

On the client system, in the Microsoft iSCSI Initiator, add the IP address of
the target subsystem.

In the Management Console, in the Tree under SAN Clients "I, right-click
an iSCSI client [, and choose Create Target from popup menu.

Click the Next button to continue.

The Create iSCSI Target dialog box opens.
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3. Inthe dialog box, enter the Target Name in the field provided.
Check the boxes of the Target IP addresses you want to use.
From the Access Mode dropdown menu, choose a level of user access.
Click the Next button to continue.
The Select virtual drives for LUNs in the Target dialog box opens.

4. In the dialog box, check the boxes corresponding to the Resources you wan
to use.

Check the Assign all the group members to client box, as desired.
Click the Next button to continue.
The Assign LUN to Target dialog box opens.
5. In the dialog box, choose a Starting LUN from the menu.
The default LUN number is O (zero).
Click the Next button to continue.
The Verify iSCSI Target Properties dialog box opens.
6. In the dialog box, verify the information and click the Finish button.
A success message displays.
7. In the message, click the OK button.

The new SAN resource @ appears in the Tree under the SAN client " to
which you assigned it.

8. On the client system, in the Microsoft iSCSI Initiator target pane, choose the
target and log in.

9. Under Computer Management, click Disk Management and verify that the
target storage appears among the Disks.

If the target storage is not visible under Disk Management, from the Action
menu, choose Rescan Disks.

Partitioning and Formatting the Storage

The logical drive must be partitioned and formatted to work with the SAN client’s
operating system. On a Windows client, you might have to do a disk rescan.
Under Computer Management, right-click Disk Management and choose
Rescan Disks in the popup menu.

When you initialize the disk, choose:
« MBR-Up to 2 TB of storage
*+  GPT - Over 2 TB of storage
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Task 13: Setting-up High Availability

High Availability (HA) refers to establishing redundant paths between the VTrak
S3000 appliance (server) and the client. HA also builds fault tolerance and
scalability into the storage solution.

Use the PROMISE Management Console to set up your HA storage. There are
four steps.

1. Virtualize the Quorum.

2. Enable a configuration repository.
3. Configure network connections.
4. Set-up a Failover.

Before You Begin

Before you begin setting up high availability, be sure that you have a dedicated
LUN of at least 12 GB on VTrak subsystem. See “Configuring your Logical
Drives” on page 50.

Virtualizing the Quorum

To virtualize the quorum:

1. Inthe Tree, under Physical Devices d SCSiI or Fibre Channel Devices &,

right-click the dedicated LUN &/ and choose Properties from the popup
menu.

The Disk Preparation dialog box opens

2. In the dialog box, choose Reserve for Virtual Device from the dropdown
menu and click the OK button.

The Warning (data loss) dialog box opens.

3. Inthe dialog box, type yes in the field provided and click the OK button.
The success dialog box opens.

4. In the dialog box, click the OK button.

The device icon changes from no letter &l to V &.

Enabling a Configuration Repository

The configuration repository maintains a continuously updated version of your
storage system configuration.

To enable a configuration repository:

1. Inthe Tree, right-click a VTrak server @| icon and choose Options >
Enable Configuration Repository from the popup menu.
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The Enable Configuration Repository wizard opens.
Click the Next button to continue.
The Select Physical Resource(s) for the Virtual Device(s) dialog box opens.

In the dialog box, check the physical devices you prepared in the previous
steps, and click the Next button.

The Select a Physical Device dialog box opens.

In the dialog box, click the device you want and click the Next button.
The Create a Configuration Repository dialog box opens.

In the dialog box, verify your choice and click the Finish button.

On the VTrak server @| icon General tab, Configuration Repository Status
shows Online.

The device icon changes from V to Q/V to indicating this is the
quorum device that contains the configuration repository.

Important

When changes are done on one appliance (server), perform a
Rescan on the other appliance before continuing.

Configuring Network Connections

You must create an IP address alias for Health Monitoring. Health Monitoring tells
each primary appliance (server) about the other appliance’s condition and when
to assume a secondary function because its failover pair is offline.

You can use the same NIC (network) port chosen during setup. See “Changing
NIC Settings” on page 18. But you must create and use a separate IP address for
Health Monitoring.

To configure the network for failover:

1.

In the Tree, right-click a VTrak server @| icon and choose System
Maintenance > Configure Network from the popup menu.

The Network Configuration dialog box opens.

In the dialog box, click the Config button.

The IP Address Configuration dialog box opens.
In the dialog box, click the Add button.

The Interfaces dialog box opens.

In the dialog box, enter a new IP address and the subnet mask, then click
the OK button.
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The IP Address Configuration dialog box opens.

In the dialog box, click the OK button.

The Network Configuration dialog box opens.

In the dialog box, click the OK button.

The network service restarts. Your connection to the appliance is lost.

To log in again, right-click the VTrak server i icon and choose Connect
from the popup menu.

Setting Up a Failover

Note

In this procedure, you must verify the secondary standby WWPNs
for both adapters in both VTrak appliances (servers)
simultaneously.

To make the process easier and to minimize the chance of error,
open a second Management Console.

In the Tree, click the SCSI or Fiber Channel Adapter. Then look for
the Adapter’s WWPN on the General tab

To set-up a failover:

1.

In the Tree, right-click a VTrak server @ icon and choose Failover >
Failover Setup Wizard from the popup menu.

The Failover Setup wizard opens.
Click the Next button to continue.

The Option Settings for the primary server dialog box opens. It tells you
which upstream protocol is currently available for failover.

In the dialog box, click the OK button.

The Failover Setup wizard opens again.

Click the Next button to continue.

The Rescan Physical Devices dialog box opens.

In the dialog box, click the Yes button to perform the rescan.
The Select the secondary server dialog box opens.

In the dialog box, click the VTrak appliance you want.
Check the Mutual Failover box.

A mutual failover is a configuration with two primary servers where each
primary server is the also secondary server for the other.
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The wizard automatically creates a configuration repository on the
secondary server.

Click the Next button to continue.

The Users List opens.

In the Users List, examine the user names for both VTrak appliances.
. If all names are identical, click the OK button.

+ If any names are different, click the Cancel button and modify the user
accounts as necessary.

If you clicked the OK button, the Select Failover Subnets dialog box opens.
In the dialog box, check the box beside the subnet for your servers.

The subnet should match the IP addresses of both VTrak appliances in the
first three octets. For example, if your VTrak appliances use IP addresses
192.168.250.160 and 192.168.250.170, then the subnet is 192.168.250.0.

Click the Next button to continue.

The Enter the IP addresses of the Servers dialog box opens.

In the dialog box, complete the IP addresses of your VTrak appliances.
Clients use these IP addresses to access the VTrak appliances.

Click the Next button to continue.

The Enter the Health Monitoring IP addresses of the servers dialog box
opens.

In the dialog box, complete the Health Monitoring IP addresses of your
VTrak appliances.

Enter the IP addresses from “Configuring Network Connections” on page 63.
Click the Next button to continue.
The Set WWPN Ports dialog box opens.

In the dialog box, choose the secondary standby WWPN from the dropdown
menu. As noted above, open the second Management Console now to verify
the WWPNSs.

For a mutual failover, each iSCSI # or Fibre Channel m adapter in one
VTrak appliance must know a corresponding secondary standby WWPN of
an adapter in the other VTrak appliance. Refer to the General tab of each
adapter to view its WWPN.

Caution

The four secondary standby WWNN dialog boxes look virtually
identical. Be careful to click the Next button one time only as you
move through the dialog boxes and make your settings.
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You must choose secondary standby WWPNSs for:

*  VTrak S3000-01 adapter 1

*  VTrak S3000-01 adapter 2

*  VTrak S3000-02 adapter 1

«  VTrak S3000-02 adapter 2

Choose the secondary standby WWPN for the first adapter and click the
Next button.

Repeat the action until all four secondary standby WWPNSs are chosen.
Click the Next button to continue.

The Configure Power Control Option dialog box for the first VTrak appliance
opens.

10. In the dialog box, choose IPMI from the dropdown menu and click the Next
button.

The Configure Power Control Option dialog box for the second VTrak
appliance opens.

11. In the dialog box, choose IPMI from the dropdown menu and click the Next
button.

The Confirm the Failover Configuration dialog box opens.

12. In the dialog box, check your settings and click the Finish button to
configure your failover.

Saving the Server Configuration

There are two methods to save VTrak appliance (server) configuration:
* Manual - Saves the *.config file to a place you choose
« Automatic — Saves the *.config file to the Repository

To save the server configuration manually:

1. In the Tree, click the VTrak server ﬁ)l icon to select it.
2. From the File menu, choose Save Configuration.

3. Inthe Save dialog box, navigate to the place where you want to save the
configuration file and click the Save button.

The *.config file is saved as you directed.

To enable a Configuration Repository in which to save the server configuration
automatically:

1. Inthe Tree, right-click the VTrak server @ icon and choose Options >
Enable Repository.

The Enable Configuration Repository wizard launches.
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Click the Next button to continue.
The Select Physical Resources dialog box opens.

2. Inthe dialog box, check the boxes beside the resource you want to use and
click the Next button.

The Select a Physical Device dialog box opens.

3. Inthe dialog box, highlight the device you want to use and click the Next
button.

The Create the Configuration Repository dialog box opens.
4. In the dialog box, verify your choice and click the Finish button.
The Configuration Repository is created on the device you chose.
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Contacting Technical Support

For assistance or more information:

Go to the PROMISE Support Website at
http://www.promise.com/support/support_eng.asp

Go to PROMISE Online Support at e-Support On-Line
Contact the nearest PROMISE Technical Support Office

United States

Fax Support +1 408 228 1100 Attn: Technical Support
Phone Support +1 408 228 1400 option 4

The Netherlands
Fax Support +31 0 40 256 9463 Attn: Technical Support

Phone Support

+31 040 235 2600

Germany
Fax Support +49 0 2 31 56 76 48 29 Attn: Technical Support
Phone Support +4902 31567648 10
Italy
Fax Support +39 0 6 367 124 00 Attn: Technical Support
Phone Support +39 0 6 367 126 26
Taiwan
Fax Support +886 3 578 2390 Attn: Technical Support
Phone Support +886 3 578 2395 ext. 8822 or 8823
Bejing, China

Fax Support +86 10 8857 8015 Attn: Technical Support
Phone Support +86 10 8857 8085 or 8095

Shanghai, China
Fax Support +86 21 6249 4627 Attn: Technical Support
Phone Support +86 21 6249 4192, 4193, or 4199
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